Dedicated to the memory of Richard Rohde

President’s Corner
by N.C. Sizemore

I hope you received some benefit
from the Photoshop Elements 8
program last month. As is usual, I as
the presenter probably learned more
than I would have as a listener. I had to
try some things I had not tried before and to read some
things I had not read before. If nothing else, this demonstrates
the value of volunteering to present a program. You, like me,
would, as a presenter, probably become even more proficient in
a program you were already comfortable with!
At the last meeting, we were asked by Joan Espenship to
please find someone to take over refreshments for three months
as John was going to be under going a three month treatment
program for cancer. I very much appreciate Della Marteny and
Ed Jaworowski volunteering to handle this. I also urge everyone
who is a praying person to put John on their prayer list and
pray for a completely successful treatment outcome.
April will be the last meeting in this club year. The May
meeting will be the first in the new year. We will elect new
officers and directors in April and their term starts at the
conclusion of the April meeting. Everyone is welcome to
nominate themselves, or any member who has agreed to serve,
from the floor during the election. All of the existing officers
Saving Custom Text Colors
By Ed Shepard

It’s easy to change the color of text
in most Mac applications. But what
if you want to use a custom color,
or copy a color from a favorite web
page or photo, and reuse this color
in an email or other document? 		
Here’s how.
First, you need to bring up the Mac
OS X color chooser. This is usually
found in an application’s menu bar
under “Format.” For example, in
TextEdit, just highlight a word, and

would be most happy to have a replacement nominated. We are
most willing to spread the honor of serving.
The board conducted a virtual board meeting and will
nominate the following slate of officers at the April general
meeting (which is also our annual business meeting).
• President— NC Sizemore
• Vice President— Dr. Roberto Putzeys
• Secretary / Membership— Nancy Kirby
• Treasurer— Judy Rankin
• Director— Tim Rankin (automatic as immed. Past President)
The following Directors are members at large. Note that we
have added one member at large (an option provided in current
bylaws).
• Director and Webmaster— Phil Davis
• Director— Chuckie Delano
• Director and Program Coordinator— Burt Stephens
• Director and Newsletter Editor— Al Sypher
We believe this slate can work well together to continue to move
the club forward. Other nominations are welcome.
I look forward to seeing you at the meeting at 7:00 PM on April
thirteenth. m
click on Format > Font > Show Colors in the menu bar. In
Mail, just highlight a word and choose Format > Show Colors.
When the Colors dialog appears, click on the color wheel in
its upper left corner. Next, use the magnifying glass to hover
over a color you’d like to copy. Click with your mouse to copy
the color to the horizontal color bar at the top of the color
chooser (next to the magnifying glass icon).
Next, click-and-hold in this horizontal color bar and start
dragging slowly—a tiny square will appear under your cursor.
Just drag-and-drop this square onto one of the white square
boxes at the bottom of the Colors dialog.
This saves that color for future use, so when you want it, all
you have to do is click once on that square (no more messing
with the color wheel). m
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Using Disk Utility - Part 1
By Phil Davis, OMUG Webmaster

One of the things I like about Mac OS X is
the availability of small utility programs
that help you use your computer more
effectively. These programs can be found
in the Utilities subfolder that is inside the
main Applications folder.
Depending on your version of Mac OS X,
you can use Disk Utility to perform the
following functions:
Erase, format, and partition hard disks
and rewritable CDs and DVDs
Run First Aid, a function that repairs file
systems and file permissions
Stripe or mirror disks in a RAID
Mount, create, and modify disk images as
well as write or burn them to disks, CDs,
and DVDs
Manually eject removable media when
other methods fail
In this tip we will focus on ways to use
the Disk Utility program that go beyond
the normal functions of managing disks.
Create a virtual DVD on your desktop
Some programs, usually games, require
you to insert a DVD into the optical drive
and leave it in while you run the program.
You can often avoid this by creating a
“virtual DVD” on your desktop using the
Disk Utility program.
Insert the DVD
Open disk utility
Select the disk from the list of volumes

Select file > new > disk image > nameofdisk
Select image format = DVD/CD Master
Select encryption = none
Select file > save

An “image” of the disk will be created
and you can eject your DVD. You can
run programs from this virtual DVD by
clicking the icon that was created, just as
you would if the DVD were in the optical
drive.
Create an encrypted folder using disk utility
This is a convenient way to create backups
of critical information files (passwords,
account numbers, etc.) and back them
up to flash drives or burn them to CD
or DVD. This uses a disk utility feature
called a “sparse image.”
Choose file > new > blank disk image
Use Save As to name the encrypted file
Select the location for the encrypted file
Create a name that will appear in the list of
devices (can be the same as filename)
Choose the maximum size for the file [example:
4.6 GB will fit on the DVD]
Choose format = Mac OS Extended (Journaled)
Choose the encryption technique [select the
recommended]
Choose no partition map
Choose image format = sparse disk image
Choose create (see photo at right).
You will then be prompted to create a password,
but you should unclick the option to store this
in your keychain.
After you have created the encrypted
folder you will be prompted for your
password when you try to open it. After
entering the password the encrypted
volume will show up in the list of devices
(or on your desktop). This device will re-

main open until you eject it. You can drag
and drop files into this virtual disk until
the size limit is reached. Depending on
the file size you can copy the encrypted
file to a flash drive or burn it to a CD or
DVD. The copied file will retain its protection and require the password to open.
I use this technique to make “portable”
backups of all my critical password and
financial data that can be stored off-site in
case of fire.
Note: If you want a flash drive or CD that
contains the encrypted file to be readable
on a PC with Windows, you will have to
change the Format selection to MS-DOS
(FAT). m
Roll your mouse over any airport for the
current conditions. • Click on the locations
too and get even more info.• Pilots sure have
a lot of toys to play with now... interactive
computer maps, glass cockpits, GPS. . .

—weather click here—
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Tips for Photographing
Butterflies

Butterflies are pretty sensitive little creatures. Get too close, and they’ll fly away in
a hurry. And, even when you do get close,
they’re constantly moving from flower to
flower, gathering their most precious prize:
sweet nectar. All this makes it difficult to
photograph butterflies, but here are 8 tips
for dealing with some of these problems:
1. Use a tripod, but keep the head loose
Butterflies move quickly from flower to
flower, so you won’t have time to lock in
your tripod. But, you can still use it for
some stability by keeping the head loose
(so you can quickly move the camera).
2. Wait for colder weather. Butterflies need
heat from the sun to use their wings, so
they like to take it easy when it’s colder
out (early morning or late afternoon). With
colder weather, you’ll be able to approach
them more easily.
3. Position your camera’s sensor so it’s
parallel to the butterfly’s wings
You only get one geometrical plane of
complete sharpness, so you want to put as
much of your subject in this plane as possible. With butterflies, you’ll want their body
and wings tack sharp, so make sure your
camera’s sensor is parallel to them.
4. Wait until butterfly is frontlit by the sun.
Side lighting will usually result in a harsh
shadow across the butterfly’s wings, and
backlighting is always difficult because of
flares. So, wait until the butterfly moves to
a position where it’s frontlit by the sun.
5. Use a fast shutter. When you’re photographing butterflies, three things are
almost always moving: the camera, the
butterfly, and the flower it’s perched on. To
help freeze the action and increase your
chances of getting a sharp photo, use a fast
shutter by increasing your ISO to 400.

6. Shoot in JPEG mode (sometimes).
If you’re having a hard time with the wind
and a constantly moving butterfly, you
may want to consider shooting in JPEG instead of RAW. This will allow you to snap
a lot more shots in a burst, increasing your
chances of getting a sharp photo (when
everything stood still for a microsecond).
7. Wait for butterflies (patiently), don’t
chase them. If the butterflies seem extra
sensitive when you’re trying to approach
them, then try to just wait patiently at one
flower instead. Although butterflies will
usually get scared if you approach them,
they’ll usually land on flowers right next
to you if you’re already sitting there. Be
patient though: it might be 15-20 minutes
before a butterfly shows up.
8. Be careful not to cast a shadow on the
butterfly. Butterflies love the sun, so if
you cast a shadow on them, they’ll usually
fly away. Remember this as you’re
approaching them. m

lights on wildflowers, causing a disaster
for exposure. So, the best time to photograph
wildflowers is on an overcast day, because
the clouds act as the perfect light diffuser:
creating the most perfectly balanced
light you can get. If you can’t wait for an
overcast day, cloudy days are good too:
just wait for a cloud to cover the sun before
taking your shot.
3. Position your camera so it’s parallel to
the most important plane of the flower.
With every photo, you only get one geometrical plane of complete sharpness. So,
to maximize sharpness in your wildflower
photos, make sure your sensor is parallel
to the flower’s most important plane, and
carefully focus your lens on this plane.

8

Tips for Photographing
Flowers

With spring on the horizon in some parts
of the world, you may be thinking about
photographing some beautiful wildflowers
soon. So, here are 8 tips to get you started:
1. Use a tripod. Using a tripod will help
you get sharper photos by ensuring your
camera doesn’t move. But, the tripod helps
in another way too: it forces you to be
more careful about your composition.
When you handhold your camera, there’s
a tendency to just snap away, but when
you add the tripod, you’ll spend more
time thinking about your composition and
ensuring your camera is in a very precise
position.
2. Wait for an overcast or cloudy day (see
photo above). Direct sunlight will cast
harsh shadows and create bright high-

4. Use a shutter speed of 1/200 or faster.
The most annoying problem you’ll face
when photographing wildflowers is battling the wind. So, to help freeze the action
of wildflowers (which never seem to sit
completely still), use a fast shutter of at least
1/200 sec. You may need to increase your
ISO to 200 or 400 to get this fast of a shutter.
5. Find a flower with a good background.
When photographing wildflowers, it’s easy
to focus all your attention on the flowers
and forget about the background. But, a
good background will help your image by
drawing more attention to your subject. So,
take the time to find a flower with a good
background: one that’s far away (to help
get it out of focus), contrasts well with the
flower, and has no distracting elements.
6. Find a flower that’s in good shape. Closely
inspect each flower before shooting to
ensure it’s not missing petals or has poor
color. Some individual flowers of the same
species will be more saturated in color
than other individuals, so take some time
to find that “perfect flower.”
7. Use a telephoto lens with a short minimum focus distance. —more on 4 >
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Photographing Flowers— continued
A long lens will help you isolate a sharp
flower against an out-of-focus background.
But, make sure you use one with a short
minimum focus distance (5 ft. or less),
to ensure you can fill the frame with the
flower. You can use an extension tube to
make your lens focus even closer for the
smaller flowers.
8. Use the RGB histogram to check
exposure, NOT the LCD preview. When
you’re outside, images on your camera’s
LCD will appear much brighter than they
actually are. So, to ensure you have a good
exposure, rely on the RGB histogram. The
histogram is a whole other topic by itself,
but the basic idea is to use the histogram to
ensure you’re not overexposing any of the
color channels in your photo.
Remember to leave no trace…
When photographing wildflowers (or anything in nature), it’s also important to leave
no trace. That means, be careful not to
step on the flowers, or disturb the ground
around them (many flowers depend on the
soil structure around them). And, it may
be tempting to attach some kind of clip to
flowers to keep from swaying in the wind,
but please avoid this because it could
potentially kill the flower. m
About the Author: Both of the articles herein are
by Steve Berardi, a naturalist, photographer, and
computer scientist. You can usually find him hiking
in the beautiful mountains and deserts of Southern
California.

Moving an
iTunes Library
As your iTunes Library
continues to grow, the time may come
when it outgrows the available space left
on your hard drive. When that happens, a
common solution is to move your library
to another (larger or more empty) drive.
Doing this is not difficult.
However, as iTunes has a number of
similar-sounding options and installs a
number of similar-sounding iTunes-related
files on your drive, it may not be self-evident how to go about moving your music
library. What makes the task potentially
treacherous is that a wrong move can leave
your music files in a state where iTunes is
no longer able to find or play them.
Here’s how to make the move—
..... from Macworld online

iPod & iPhone
Software Updates
By Jon Spaulding

When iPod was first
introduced, and up
until late 2006 or so,
there was a standalone utility that ran
checked for and installed software and
firmware updates for iPods. The iPod
Update Utility was a simple item that was
saved in your Utilities folder and automatically launched when anything new was
available. One great feature of this simple
updater is that it archived each update so
subsequent updates to other iPods did not
need to be re-download.
Nowadays, iPod updates come directly
through iTunes. If there’s anything new
when you plug in your iPod, iTunes will
alert you and ask whether you’d like to
apply them. Because part of my job is to
rest and refurbish used iPods, I find myself
needing to perform these updates all the
time; our rural location also means we
don’t have the fastest internet access, so not
having to re-download updates is a boon.
While the iPod Update Utility stored the
update files in plain view, iTunes tucks
them away in your User’s library folder at
~/Library/iTunes/iPod Software Update.
This file is only accessible to the user
currently logged in, so if you have multiple
users on your computer, each update will
download once per user.
As the iPod operating system (commonly
called iPhone OS) grows more robust in
features and stability, it also grows
considerably in size. Under the new paradigm, the old versions of the software are
not updated and replaced, but a new version is added to the User’s folder at the cost
of 225MB or more per update. Weeding
out older updates will help in conserving
hard drive space when you come upon the
ceiling of storage for your machine.
Another thing to consider if you have an
iPod that fails to update is that maybe it is
one of the updater files that is corrupted.
If your iPod seems dead and you can’t
restore it, try removing the updater files
from ~/Library/iTunes/iPod Software
Update. Restart iTunes and let the updates
come down again, and you may just be
lucky enough to get that iPod up and
running again. m

Get Info From Within
Spotlight—
I recently discovered that you
can use the Get Info command directly
within Spotlight. Simply search for the file
you’re looking for in Spotlight, highlight it,
and hold down Command and I at the
same time. This is a very speedy way to
get info on any file on your Mac!
By Ed Shepard

Six Tips For Using The
Dock Efficiently!
by Kirk McElhearn, Macworld.com

Make sure you’re getting the most out of
this basic OS X tool—
OS X’s ever-present Dock can help you
manage your applications and documents.
But are you taking advantage of all the
ways it can make your work easier?
Here are some tips for using the Dock efficiently—whether you’re quickly accessing
files, folders and applications or turning on
and off your tunes.
1. Add what you need. The Dock contains
two sections: one for applications and the
other for files, folders, and the Trash.
If your Dock is at the bottom of your
screen, you’ll find applications to the left of
the separator (the dashed line). Some icons
stay in the Dock permanently. Click on
these for quick access to their programs.
Likewise, you can drag a compatible file to
an icon to open it in that program.
You can drag any application from a
Finder window to the Dock to add its icon.
Don’t want something that’s already there?
Drag its icon off and it disappears in a puff
of smoke.
You’ll also see icons for all applications
that are currently running. (They appear
with a bright dot beneath them.) These
icons disappear from the Dock when you
close the programs. If you want to keep
an application icon in the Dock, click and
hold on it, and then choose Options ->
Keep In Dock.
The other side of the Dock’s separator
holds files, folders, and the Trash. Take advantage of this feature to get quick access
to files you work with often—or even just
for the time of a project. —more on 5 >
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Using The Dock— continued from 4
Drag a file or folder to the right (or bottom)
section of the Dock. Wait a second for a
space to open up, and then place the item
where you want. (The icon is just a pointer
to your file; the
original file doesn’t
move.)
2. Get quick access
to a folder. With my
home folder in the
Dock, I can navigate
all of its sub-folders
without going to the
Finder.

It’s a cinch to add
a folder to the
Dock—just drag it on for easy access to
those files. Once the folder is there, you
also have a number of options for how it
displays. By default, in Snow Leopard, the
folder shows as a “stack” that contains a
number of icons piled one upon another.
The folder also displays in grid mode,
showing its contents as icons in a large
pop-up menu when you click on it. But
grid mode only lets you click the subfolders in your folder to open them; you can’t
navigate them that way.
Instead, you might want to Control-click
on the folder icon in the Dock and choose
View Content As List. This displays the
folder’s contents as a list in a pop-up menu
when you click on it. Now you’ll see that
the subfolders contain arrow icons to the
right of their names. This means that if
you select a folder, you can then drill down
into its contents. Using list view, you can
effectively navigate the hierarchy of any
folder. For example, put your Documents
folder in the Dock, in list view, and you’ll
be able to find and open any files it contains
without having to go to the Finder.
3. Store or launch URLs. The Dock can
also hold URLs—click on one of these @
signs on springs and your default Web
browser will launch and open the Web
page. This can be useful when there is a
Web page you want to find without hunting
through your bookmarks. To add a URL to
your Dock, first open the Web page in your
browser. Select the icon next to the URL
in the Address Bar, and then drag it to the
Dock. Now you can access its page with
a single click. If you store more than one
URL this way, you might forget which @
sign corresponds to which Web page. No
problem. Hover your cursor over the icon

and the full name of the page appears.

6. Access program options.

There’s also quick way to use the Dock to
open a Web page when you come across
a URL in a document. Select the Web
page address (complete with the http://
part) and drag it to the Safari (or Mozilla
Firefox) Dock icon. The page will open
automatically. (That’s a quick way to open
a Web page in a browser that’s not your
default.)
4. Access Exposé from the Dock. When
you want to maneuver among your
windows, you can use the Dock to click
and bring an application to the fore. But
if you’re using Snow Leopard, there’s another way that lets you view—and choose
from—open windows in a version of OS
X’s Exposé.

View multiple windows, just like in Exposé, then
click the one you want to go to.

Click and hold your mouse button down
on a Dock icon. You’ll see the window (or
windows) of the program belonging to
that icon against a dark background, a la
Exposé. Now, when you release your
mouse button, the window(s) won’t go
away. Click another Dock icon to see the
window(s) for another application, then
another icon, and so on. As you do this,
you can examine the windows for all your
active programs, and choose the one you
want to see by clicking on it.
5. Hop to System Preferences. Need to
change your desktop background or tweak
your Energy Saver settings? It’s easy to
jump to any of OS X’s System Preferences
panes using the Dock. Click and hold the
System Preferences icon (it looks like a set
of gears) to see a list of preference panes
appear. Then simply choose the one you
want, click on its name, and System Preferences will open to that preference pane.

You can access many useful options by controlclicking (or right-clicking) on a program icon in
the Dock. For example, you can pause or play
a song in iTunes without having to switch your
focus over to that program.

If you Control-click or
right-click on a running
program’s Dock icon, you
may find useful options in
the contextual menu that
appears. For example, if you
Control-click on the iTunes
icon when the program is
running, you can choose
Play, Pause, Next, Previous
and some other functions.
If you Control-click on
Word’s icon, you get access
to an Open Recent menu; its
sub-menu lists the documents
you’ve used recently. Try this with the
applications you use most and you’ll
start enjoying some of the Dock’s real
potential. m
Firewire External Drive Back-up To
Boot 2 Different Mac Computers???
So you have a new FW external drive
and you want to partition it to serve as a
bootable drive for both a MacBook Pro
and a G5 Tower— not so fast Al. The two
computers have different processor architecture with differing requirements. The
MBP requires a GUID partition while
a G3, G4, or G5 needs an APM partition to be bootable. You have to choose
a partition format of one or the other, not
both. For example: your MacBook Pro can
have a complete back-up and you can run
the operating system from the Fire Wire
external drive if ever needed. A G3, G4, or
G5 will have a complete back-up but no
boot capability or vice-versa. —Al Sypher
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OCALA MACINTOSH USER GROUP — MEETING MINUTES: February 9, 2010— Preliminary
President Sizemore called the meeting to order at 7:05 PM. In the absence of our Secretary and Assistant Secretary he asked Shelley
Sizemore to take the minutes.
Announcements and Introductions: NC thanked Phil Davis for doing a great job with the question and answer program in February.
He mentioned that Phil and Brian had been working on establishing a reliable Internet connection for our area but this has not been
fully successful as yet. After other welcoming statements he asked who was visiting and had the following visitors introduce themselves: Dave Hitchcock, Daniel Pope, Kathleen Fleck, Michelin Claussen, and Kathleen and Charles Reich.
Our refreshment team of Joan Espenship and John Derr informed us that John will have to have extensive treatment for cancer over
the next three months and asked for some temporary help. We are very appreciative that Della Marteny and Ed Jaworowski stepped up
and said they would take over refreshments for three months. Thank you very much!
New members were: Suzanne McGregor and Vince and Marilyn Andrews.
Secretary’s Report: Mr. Sizemore asked if there were any corrections or additions to the minutes from the prior meeting as posted on
the website. There being no changes, the minutes were accepted as posted.
Treasurer’s Report: Judy Rankin gave the Treasurer’s Report. We had $1,370.53 in the treasury. The report was approved and accepted.
NC mentioned that we still want and are accepting bios for our web page. and that he would be available to take portraits at the break.
We are not trying to coerce anyone who doesn’t want their information on the Internet to post it, but we are reminding those who just
haven’t gotten around to it yet that we still want the info. A question was raised about what should be written. The answer was to read
what is out there for samples and follow the one you like best. This could include home town, education, occupation, years in Ocala,
years in OMUG, years using a MAC, what you use your MAC for, and/or other. You are also free to omit anything you do not wish to
include. We are not fussy; we just want to get to know you better. The information is in a password protected members only area. Phil
Davis gave the password which I am intentionally not repeating in a document subject to wide circulation.
NC again urged the members to make program requests known and to volunteer to present programs. He also urged everyone to
bring a guest next time.
Program Topic: The basics of Photoshop Elements 8— using very simple ways to greatly improve problem photos.
Program Highlights: Presented by N.C. Sizemore, he emphasized that this is a demonstration - not a tutorial.
He warned to never edit an original image— make a copy and edit it. Save both the original and the copy separately for future use. He
took a picture, intentionally underexposing it, and loading it into his computer all in a matter of about two or three minutes. This was
to show how easy it is to get an image into the computer. He then mentioned other ways of doing the same thing: memory card reader,
memory card slot on some computers, memory card slot on some printers, photos from CDs, memory sticks, Internet, or scanners.
Photoshop Elements 8 has three basic edit modes. Edit Full, edit Quick, and Edit Guided. NC first demonstrated Edit Full: in this
mode he demonstrated cropping (with a discussion on resolution and aspect ratio) • using the edit undo function to fix mistakes •
using view to maximize the picture on the screen • using the zoom tool (he called it the magnify tool) • using the straighten • red eye
removal • enhance lighting • clone • blur, and sharpen tools.
He said you always crop first and sharpen last.
Next he demonstrated Edit Quick, using automatic tools to accomplish much the same results, and concluded with Edit Guided to
show that there are tutorials to guide you along the way as you use the most popular tools.
We had a break during which a few portraits for the website were made; a lot of socializing and informal Q and As were handled and
delicious refreshments were served.
After the break Phil Davis gave us about five quick tech tips. They (along with many other tips) can be found on our website (link at
bottom of home page) under the heading Tech Help or bookmark < http://ocalamug.org/wp2/ >.
Raffle: In Earl Satterfield’s absence, Tim Rankin handled the 50-50 and raffle. Thanks Tim! We had five raffle prizes:
• Two individuals (Elaine Smith and Phil Davis) took Cash prizes worth over $20.00.
• Marilyn Andrews won a memory card reader.
• Bud Gellenthin went away with a new hub.
• Stan Piteau was happy with a new USB cable.
The meeting adjourned at 9:10 PM.
Respectfully submitted,
Shelley and NC Sizemore
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OMUG TREASURER’S REPORT — MARCH 2010
Account Balance 3/01/2010

. ........................................................................................................ $1370.53

Income 3/9/2010 Meeting:

2010—2011 Memberships.................................60.00
50/50 Raffle Tickets sold................................... 47.00................... + 107.00

Expenses:

50/50 Raffle Prize Items....................................46.89
Refreshments (Feb. & Mar.).............................. 21.00
New Name Tag Supplies.................................. 71.68..................... -139.57

Account Balance 3/31/2010

. ........................................................................................................ $1337.96

OMUG Meeting Information—

Mac Users Helping Mac Users—

OMUG Assignments—

The Ocala Mac User Group meets on the
2nd Tuesday of the month at the following location to the southeast of Ocala:

OMUG volunteers will try to help you with
your computer and software problems.
Please add your name to this list if you
are willing to share your expertise with
other OMUG members.
General Mac Problems–
Tim Rankin
rank.tim@gmail.com • 821-2201
Print Shop or Print Explosion–
Judy Rankin
judyrankin@mac.com • 821-2322
AppleWorks or MS Word–
Curtiss Besley
cbesley@mac.com • 266-6760
General Mac Problems; Web Design
Philip Davis
davistech@gmail.com • 369-8432

Assist. Secretaries– Sally Smyth and
Shelley Sizemore
Treasurer– Judy Rankin
Fifty-Fifty Raffle– Earl Satterfield
Membership– Nancy Kirby
nkirby1944@embarqmail.com
Newsletter– Al Sypher
aes@imageocala.com • 237-9501
Refreshments– Shirley Steiner and
Joan Espenship
Sunshine Lady– Virginia Baldwin
vbaldwin@atlantic.net • 629-6308
Webmaster– Philip Davis
ocalamug@gmail.com • 369-8432

St. George Anglican Cathedral—
Parish Hall
5646 SE 28th St., Ocala, FL 34471
(352) 624-0112
See www.ocalamug.org for a map to the location.

OMUG Board of Directors—
President– N.C. Sizemore
ncsizemore@gmail.com • 291-8778
Vice President– Philip Davis
davistech@gmail.com • 369-8432
Secretary– Nancy Kirby
nkirby1944@embarqmail.com
Treasurer– Judy Rankin
judyrankin@mac.com • 821-2322
Member-at-Large– Bob Docteur
docteurr@aol.com • 624-0524
Member-at-Large– open
Member-at-Large– Al Sypher
aes@imageocala.com • 237-9501
Past President, Ambassador–
Tim Rankin
rank.tim@gmail.com • 821-2322

Remember When!

Funny Sign:
The name of a beauty shop in Illinois:
“Curl Up & Dye Hair Salon”

What 200 MB looked like in 1970.....
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